
                  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Cyril Poirier and Manuel Sanchez del Rio 

 
October 2001 

 
 
 
 
 
 
 
 
 
 
 

                                         
 
 



 2

 
Preface 
 
 
BLViewer is a software tool to create interactive 3D representations of optical 
systems. An optical system is composed by a source and one or several optical 
elements arranged sequentially. BlViewer has been design for displaying optical 
systems ray-traced by SHADOW (www.nanotech.wisc.edu/shadow/shadow.html) It is 
distributed as an application of the ShadowVui interface to SHADOW, available in the 
XOP package (www.esrf.fr/computing/scientific/xop)  
 
 
 
 
 
 
 
 
 

 
Fig 1- Example of an an optical system as represented by BLViewer. The rings 
represent the source, several optical elements (mirrors and crystals) are displayed with 
their respective surface normal. A molecule symbolized the sample.  

http://www.nanotech.wisc.edu/shadow/shadow.html
http://www.esrf.fr/computing/scientific/xop


 3

 

PREFACE 2 

GLOSSARY 4 

FUNCTIONAL DESCRIPTION OF BLVIEWER CONTRONS 5 

STARTING BLVIEWER 5 
THE MAIN WINDOW 6 
MENU BAR 7 
BUTTONS 7 
GRAPHICAL AREA 8 
INFORMATION’S TEXT 8 
DIALOG BOXES TO CONTROL THE 3D REPRESENTATION 8 
SOURCE CONTROL 8 
MODULE CONTROL 9 
GLOBAL CONTROL WINDOW 12 
PLANES CONTROL WINDOW 13 
RAYS CONTROL WINDOW 15 

EXAMPLES 18 

EXAMPLE 1 18 
EXAMPLE 2 19 
EXAMPLE 3 20 
EXAMPLE 4 22 

SUGGESTIONS AND BUG REPORTS 22 

 
 
 
 
 
 
 
 
 



 4

Glossary 
• Optical system: A set of elements and planes. It contains a source 

(mandatory) and a number of optical modules (optional) concatenated one after 
the other. 

• Source: The space region from where light is emitted. By default, the source is 
placed on the left of the view. BLViewer shows a coordinate reference frame 
in the place of the source, from where photons (i.e., rays) are emitted.  

• Optical module (o.m.): A region of space containing one optical element and 
a minimum of two optical planes, one before the optical element. (source 
plane) and another after the after the optical element (image plane). It can 
optionally contain more planes.  

• Optical element (o.e.): an element that reflects, refracts or diffracts the beam. 
Usually mirrors, lenses, multilayers, crystals, etc. The nature of the optical 
element is not important for BLViewer, as it will be represented like a kind of 
box. The optical surface is flat, even in the case where it has been defined 
curved in SHADOW. Usually the curvature radii are be so large that they 
would appear as plane. A customized 3D object can be optionally loaded (in 
this case, the optical surface can be anything) 

• Optical Axis: The straight line joining the center of optical planes and o.e’s in 
the order that they are intersected by the beam. 

• Optical plane (o.p.): a plane positioned perpendicular to the optical axis. 
Optical planes are used to define the boundaries of the o.m. and to see beam 
cross sections.  

• Normal: the normal to the o.e. surface at its center 
 



 5

 
Functional description of BLViewer controns 
 
Starting BlViewer 
 
BlViewer is started from the SHADOWVUI main window (see Fig. 2), using the 
“BLViewer” button or the “Results” item in the menu bar.  

 
Fig 2 The SHADOWVUI main window. Circles are shown from the places where it is 
possible to launch BLViewer. 
 
If BlViewer is started by clicking the button, the optical system in the working 
directory is loaded. In this case, the optical system parameters are read from the 
SHADOW files systemfile.dat and end.xx. If BLViewer is started from the 
menu bar, no system is loaded.  
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The main window 
 
The BLViewer window (Fig 3) contains a menu bar, several buttons, a large graphical 
area where the 3D representation is displayed, and an information field. 
 
 

 
 
Fig 3 The main BLViewer window. 
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Menu bar 
 

With End.xx Opens an Optical System using 
“end.xx” files. 

System File 
(*.dat) >>>> 

With Start.xx Using “start.xx” files. 

Open >>>> 

BlViewer File 
(*.blv) 

Opens an Optical System saving in BlViewer 
format. 

Save As… Saves the current Optical System in BlViewer format. 
Realod Reloads the files with the definition of the representation and refreshes 

the display. 
Print… Creates a hardcopy of the representation. 
Grab Picture… Creates a new window with a bitmap of the representation, for being 

saved to a disk file.  

File > 

Quit Closes BlViewer. 
Edit > Delete optical 

module 
Deletes the currently selected optical module. 

Add > Optical Module… Adds an Optical Module and pops up the parameters window. 
Perspective Show 3D representation from a predefine view. 
Top View (X/Y) Shows 3D representation from top.  
Side View (Y/Z) Shows 3D representation from a side.  
Front View (X/Z) Shows 3D representation from the front.  
Perspective… Rotates the predefine view with users customized angles. 
Linear Inter-mirror distances in linear scale. 
Logarithmic Inter-mirror distances in are represented as the logarithmic of the real 

ones. 
Frame Optical elements and objects are transparent (only a frame is shown). 

View > 

Opaque Optical elements and objects are opaque. 
Optical Elements Show/Hide optical all elements. 
Optical Axis Show/Hide all optical axes. 
O.E. Normal Show/Hide Normal on all o.e. 

Show > 

O.E Axes Show/Hide axes on all modules. 
Rotation (start/stop) Rotate the 3D representation. Use the same option to stop animation. Animate > 
Rays (start/stop) Trace rays slowly. Rays must be loaded. Use the same option to stop 

animation. 
Option > Background 

Colors… 
Change background color. 

Help… Display help on BLViewer Help > 
About… Display information on BLViewer. 

 
Note that some options are accessible from several places in interface. 
 

buttons 
 
Quit Close the application. 
Reload Reloads the files with the definition of the 

representation and refreshes the display. 
Source Open a dialogue box with source controls. 
Module Open a dialogue box with optical module controls. 
Rays Open a dialogue box to load and trace rays. 
Global 
Controls 

Open a dialogue box to control parameters that affect 
globally all modules 
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Graphical area 
 
Interactive actions on the representation can be applied by using the mouse. Left-click 
and drag to rotate the representation. Right-click and drag it to translate the view. 
 

Information’s text 
 
It gives some information about the status of BLViewer. 
 
Dialog boxes to control the 3D representation 
 

Source control 
 
The source is the first piece of the representation. It always exists. It is composed by 
the three axes of the reference frame and its labels. A user customized object can be 
optionally loaded from a mesh in a *.wrl file (VRML format version 2.0). It can be 
resized and replicated in three directions. The control’s description is in Fig. 4. 

 

 
Fig 4 The Source control window. 
 

Dismiss the 
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Warning: it can be very long to load and display a complex mesh. Thus, use repeat 
operation with moderation. 
 

Module control 
 
This window present controls to modify the optical module attributes. The components 
of a module are represented in Fig. 5 
 
 

  
 
 
Fig. 5: Graphical representation of the components of the optical module.  
 
The position and orientation of a module (Fig. 6) is defined with two distances and 
two angles. The source plane of a generic module n is placed at the same position than 
the image plane of the module n-1. For the first module, the source plane is coincident 
with the plane XZ of the source. BLViewer displays all planes of the modules, in spite 
of this redundancy. It is then possible to switch on and off any module independently 
of the others.  
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig. 6: Schematic description of the positio
module.  
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The description of the module control window is in Fig. 7 
 
 
 
 
 
 

 
 
 
 
 
 
Fig. 7. Description of the controls for the optical module.  
 
 
BLViewer has four types (see Fig. 8) of built-in o.e’s: Rectangular, Ellipse
with a hole, and Infinite surface (displayed using an irregular shape). In addit
possible to importe an external mesh file in the VRML (version 2.0) format  u
option “External (VRML)”. An example is shown in Fig. 9. 
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A)     B)  
 
 

C)     D)  
Fig 8. BLViewer pre-built o.e.’s: A) Rectangle, B) Ellipse, C) Ellipse with a hole, and 
D) Infinite surface. 
 

 
Fig 9: Example of a customized concave mirror from a VRML file 
(concaveY.wrl), Two other files, concaveX.wrl and concave.XY.wrl 
contain other curved o.e’s, bent in the sagittal direction and in both directions, 
respectively. 



 

By clicking the ‘Geometry…’ button of the module control window one obtains the 
dialog box to modify the dimensions of the o.e’s. The “Position…” button opens a 
dialog box to change the positioning of the o.e. and image plane. If you are using a 
customized VRML object, you can also also use these parameters.  
 

Global control window 
 
 

  
Fig 10. Global co
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ntrol window. 
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Planes control window 
 
An optical plane is a flat surface placed perpendicular to the optical axis. It intersects 
the beam and allows to visualize the beam cross sections.  
A typical shadow run uses few thousand rays. It is difficult to get visual information 
from all of them in a 3D representation. To make the visualization clearer it has been 
implemented the possibility to paste a bitmap image on an optical plane (see Fig. 11). 
In addition to the two planes that always exist in a module (source and image) it is 
possible to add any number of additional planes. In the case that planes are defined in 
SHADOW (called screens) they are loaded in BLViewer. In the optical module, it 
exists an invisible flat surface in the plane XY where it is also possible to paste a 
bitmap image.  
 

Fig 11: An example of an optical system where the beam cross sections are 
represented with bitmap images created by BLViewer from SHADOW’s files. One 
can see how a large beam intercepts partially a mirror, and how is reflected. The 
optical element is not visible. Instead, a bitmap image is pasted on its surface plane. 
 
To define the optical plane parameters, click on the “modify…” button of the module 
window. A new window appears, as shown in Fig. 12. 
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Fig 12
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: Control window for optical planes.  
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Click on “Image…” button to start an image processing (Fig. 13) application that 
allows to load and create a bitmap image. 
 
There are two ways to get a picture: 

1. Load it from a disk file using the load button. 
2. Create it using the information of the rays calculated by SHADOW on top of 

the selected plane. By using the button “Make bitmap with rays” a bitmap with 
the image of the rays is produced. For that, as in SHADOW, all rays, good 
rays, or only lost rays can be used. Of course, rays have to be loaded 
previously (see Rays controls) in order to create such image. The dimension of 
the image is found at the bottom of the window. It is possible to edit it (and 
type <enter>) to recreate the image with customized size. 

 
Once a bitmap image is loaded or created, it is possible to smooth it (using the 
“Smooth” button) to make a better representation of the beam density. 
The result can always be saved to a disk file. However, it is not necessary to create the 
file in order to use the image. Just click on “Apply” button and the image will be 
exported to the optical system representation.  
 

Rays Control window 
 
BLViewer does not calculate the ray trajectories of your optical system. It gets them 
from SHADOW’s files.  
SHADOW calculates the intercepts of the rays with the optical planes and puts these 
coordinates in different files. BLViewer reads these files and displays this information 
using three kind of graphical items (see Fig 14): 

• Points: the interception points between the beam and optical planes and o.e’s 
surfaces are displayed. 

• Vectors. There is a vector starting at the position of each ray. The direction of 
the vector coincides with the direction of the ray. 

• Lines: Straight lines are used to join intercept points between planes and o.e’s.  
 
There are two types of rays in SHADOW: good rays and lost rays. Rays are lost when 
they intercept the o.e. surface outside its physical dimensions. Lost rays hurt the o.e’s 
plane without hurt the o.e’s surface. The rays control window is popped-up when the 
“Rays” button in the main plane is pressed. This panel is described in Fig. 15 
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A)  

B)       C)  
 
Fig 14. The three types of ray representations: points (A), vectors (B) and lines (C). 
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ig 15. The rays control panel 
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Examples 
 
Example 1 
 
Open the SHADOW workspace ex11a.ws. Answer “No” to the asked questions. 
Then  

• run the source by pressing “Run SHADOW/source’ in the main 
SHADOWVUI window 

• run the pre-coded macro by pressing the “Run macro button” in the main 
SHADOWVUI window. (This macro redefines the flag for some rays in the 
source).  

• Press “Run SHADOW/Trace” 
• Click on the ‘BLViewer’ button. You get the window in Fig 16. Experience 

rotations and translation by left and right-clicking (respectively) and dragging. 
• Click on “Rays” button in th BLViewer window. A new window pops-up 
• Click on “Load” button to read SHADOW’s result files. Then click on “Add” 

button several times to display rays as points. You get the the representation in 
Fig. 17, where the good rays are displayed in red and the lost rays in yellow. 
You can switch now to “line” representation.  

• Press the “Quit” button to close the BLViewer window. 

 
 
Fig 16: Default representation for the SHADOW’s system from workspace ex11a.ws 
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Fig 17. Optical system with rays represented as points. Red points represent good rays 
and yellow points are for bad rays. 
 
Example 2 
 
This example shows how it is possible to create customized views of optical 
instruments without using SHADOW. Of course, no rays can be represented.  
 

• Start BLViewer from the “Results’ item in the menu bar of ShadowVUI 
• From the menu bar use “Edit” and “Add optical module” three times, to create 

three optical elements.  
• Click on the ‘source” button, hide all axes and labels, and load the VRML file 

ring.wrl. Replicate it in Y direction from 0 to 1 with step 0.1. Play with the 
zoom. The result wants to symbolize an undulator.  

• Select “modules” panels, and for the o.m. 1 and 2 load the VRML files 
concaveXY.wrl and concaveX.wrl, to represent curved mirrors. Hide 
labels, axes and planes.  

• Let is define a sample symbol (a molecule). As it is not possible to load an 
external VRML file associated to an optical plane, we have defined a third 
module, with the intension of placing our sample in the o.e. position. Select the 
third module, set under the “Position…” window the distance equal to zero. In 
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the shape corresponding to this module, load the VRML file molecule.wrl. 
Play with the zoom.  

• Set the background color to white (i.e., [255,255,255]) using Options-
>Backgroud colors… 

• Using the “File->Grab picture” option, create a jpeg file with the view. The 
result is shown in Fig. 18 

 

 
Fig 18. Result from example 2 
 
 
Example 3 
 
Let us create some views of a focusing mirror using some rays. Load the 
SHADOWVUI workspace file example3.ws that contains a conic grid source with 
only few rays and a toroidal mirror. Run it. Open BLViewer using the “BLViewer” 
button in the SHADOWVUI window. Using the “Ray” window, load the only 8 
existing rays and visualize them as lines. Remove labels and normals of the optical 
module and source. Play with the zoom, rotations, etc. Some views are in Fig. 19. 
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A)

B) 

C) 

 
Fig 19: Focusing mirror: A) Perspective view, B) Top view , and C) Side view.  
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Example 4 
Run the SHADOWVUI workspace example4.ws containing a system composed by 
a first collimating mirror and a second refocusing mirror. The beam cross sections are 
converted to bitmaps and then smoothed using the BLViewer image-processing tool 
under the optical plane controls. In order to compare the cross sections at different 
plane, the image dimensions are set to [0.05,0.05] in all planes. After removing 
labels, normals, etc. and playing with zoom and distances one can get a figure like in 
Fig. 20 

 

 
Fig 4. View of example 4, showing a first collimating mirror (on the left) and a second 
refocusing mirror. The beam cross sections are smoothed bitmaps calculated using 
data from SHADOW’s files. 
 
 
 
Suggestions and bug reports 
 
Please send them to Manuel Sanchez del Rio <srio@esrf.fr> 
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